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INTRODUCTION

This document is intended for administrators of the Xerox® EX Print Server Powered by 

Fiery® for the Xerox® iGen 150 Press, which is referred to in this document as the EX Print 

Server.

This document primarily describes tasks that must be completed or coordinated by the 

administrator before the EX Print Server is ready for use. It assumes that the EX Print Server 

has been unpacked from its shipping container and that all required cables are connected from 

the EX Print Server to the network, a power source, and the digital press, and that the digital 

press is operational.

If you are an administrator and plan to configure a EX Print Server, it is strongly 

recommended that you carefully review this entire document, beginning with “Stages of 

installation on the network” on page 9.

About this document

This document includes information about the following:

• System Requirements

• Setting up from a Client Computer

• Setup Option Reference

• WebTools

• Back up and Restore Settings

• Administration

• Troubleshooting
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Terminology and conventions

This document uses the following terminology and conventions.  

Term or convention Refers to

Aero EX Print Server (in illustrations and examples)

Digital press Xerox® iGen™ 150 Press

EX Print Server Xerox® EX Print Server Powered by Fiery® for the Xerox® iGen 150 
Press

Titles in italics Documents in this set: Color Printing, Configuration and Setup, 
Fiery Color Reference, Fiery Graphic Arts Package, Printing, Utilities, 
Variable Data Printing, Workflow Examples

Windows Windows 8, Windows 7, Windows XP, Windows Vista, Windows 
Server 2003/2008/2008 R2/2012

Topics for which additional information is available by starting 
Help in the software

Tips and information

A warning concerning operations that may lead to death or injury 
to persons if not performed correctly. To use the equipment safely, 
always pay attention to these warnings.

A caution concerning operations that may lead to injury to persons 
if not performed correctly. To use the equipment safely, always pay 
attention to these cautions.

Operational requirements and restrictions. Be sure to read these 
items carefully to operate the equipment correctly, and avoid 
damage to the equipment or property.
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Stages of installation on the network

Installing the EX Print Server on a network requires configuring the network environment, 

connecting the EX Print Server, preparing computers for printing, and administering the EX 

Print Server after installation.

Configure the network and servers, and ensure that there is a live network connection before 

you configure network settings in Setup. This allows the EX Print Server to query the network 

for zones, servers, and server-based queues.

Whenever you change the configuration of the EX Print Server, digital press, or network at 

your site, alter the settings to correspond to the changed environment. Changing network or 

port settings may require that you make changes to other Setup options, as well.

TO INSTALL THE EX PRINT SERVER ON THE NETWORK

1 Configure the network environment.

Configure network servers to provide users with access to the EX Print Server as a network 

printer. For information about configuring network servers in Windows and UNIX network 

environments as they relate specifically to the EX Print Server, see page 16. For information 

about using your network, see the documentation that accompanies your network.

2 Physically connect the EX Print Server to a functioning network.

Prepare a network node for the EX Print Server. Obtain cable, route it to the location where 

the EX Print Server is to be installed, and attach the cable to the network connector of the EX 

Print Server. For details, see page 18.

3 Set up the EX Print Server.

Configure the EX Print Server for your printing and network environment (see page 24).

4 Prepare computers for printing.

Install the files needed for printing, install user software, and connect computers to the 

network. The software installation is described in Printing.
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Battery information for the European Union and EEA

This symbol indicates that the batteries and accumulators used in this product must be 

disposed of separately from household waste in accordance with EU Directive 2006/66/EC 

(“Directive”) and local requirements.

If a chemical symbol is printed beneath the symbol shown, in accordance with the Directive, 

this indicates that a heavy metal (Hg = Mercury, Cd = Cadmium, Pb = Lead) is present in this 

battery or accumulator at a concentration higher than an applicable threshold specified in the 

Directive.

Batteries and accumulators must not be disposed of as unsorted municipal waste. Users of 

batteries and accumulators must use the available collection framework for the return, 

recycling, and treatment of batteries and accumulators.

If your product contains non-removable batteries, the entire product is already covered by the 

EU WEEE (Waste Electrical and Electronic Equipment) Directive and should be handed over 

to an authorized collection site for WEEE. The collection site will take appropriate measures 

for the recycling and treatment of the product, including the batteries.

Customer participation in the collection and recycling of batteries and accumulators is 

important to minimize any potential effects of batteries and accumulators on the environment 

and human health due to substances used in batteries and accumulators.

In the EU, there are separate collection and recycling schemes for batteries and accumulators. 

To find out more about recycling schemes for batteries and accumulators available in your 

area, contact your local city office, waste authority, or waste disposal facility.
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SYSTEM REQUIREMENTS

Before you set up the EX Print Server, it is strongly recommended that you review all of the 

system requirements.

Levels of access and control

When you configure the EX Print Server during Setup, you implement a particular level of 

control by configuring these elements:

• Users and Groups

• Print connections

• Access to WebTools

Users and Groups

With Configure, you create users, assign passwords to users, create groups with specific 

privileges, and assign users to the groups. Several groups are provided by default, and you can 

create new groups. All users in a group have the same privileges.

In addition to assigning the users that you have created to a group, you can add users from 

your organization’s global address list if you enable LDAP services on the EX Print Server.

The following discussion is an overview designed to help you prepare a security strategy. For 

more information, including specific procedures, see Configure Help.

You can view detailed information about users and groups that you have created from 

Configure in Command WorkStation. For more information, see Command WorkStation 

Help. 

User authentication

The term “user authentication” means the EX Print Server verifies that the user who is 

sending a job belongs to a group, and the group has printing privileges (“Print in B&W” or 

“Print in Color and B&W”).

By default, the EX Print Server does not enforce user authentication. That is, even if you 

assign passwords to users and assign users to groups, no authentication occurs unless you clear 

the “Allow users to print without authentication” option (in Configure > Users and Groups). 

If this option is selected, anyone can print to the EX Print Server.

NOTE: You cannot enable EX Print Server authentication and digital press authentication at 

the same time.
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If you require users to specify their user name and password (that is, you clear the “Allow 

users to print without authentication” option), users must type this information in the printer 

driver when they print. Users must specify their user name and password if they create files 

from the printer driver for printing later (such as an email attachment that is sent to the EX 

Print Server).

Because jobs that are sent through FTP do not require a printer driver, you can specify that 

FTP jobs are authenticated (see Configure > Network > Services > FTP > Require Password 

for Printing).

Passwords

When you create a user in Configure > Users and Groups, you can set a password for the user. 

Set passwords for the Administrator (default user in the Administrators group) and Operator 

(default user in the Operators group) in Configure > Server > Password. You can also set a 

password for the Administrator during initial setup with the Fiery Setup Wizard. 

The default Administrator and Operator passwords are Fiery.1 (case-sensitive). It is strongly 

recommended that you change passwords periodically to protect the EX Print Server from 

unauthorized changes.

For more information, see “About Fiery Setup Wizard” on page 25, “Administrator 

privileges” on page 12, “Operator privileges” on page 13, and Configure Help

Operating system passwords

Since the EX Print Server is a Windows-based system, a password for the Windows operating 

system is required, which is separate from the Administrator and Operator passwords (see 

page 35).

The default Windows operating system password is Fiery.1 (case-sensitive). It is strongly 

recommended that you change passwords periodically to protect the EX Print Server from 

unauthorized changes.

Administrator privileges

Users in the Administrators and Operators groups have privileges in addition to the ones that 

you set when you create groups. Users in the Administrators group have the highest level of 

control. Administrator privileges include

• Configuring the EX Print Server from Configure or the press user interface

• Adding and deleting groups

• Adding and deleting users

• Setting and changing passwords for users

• Deleting, printing, exporting, and viewing the Job Log

• Deleting, viewing, and modifying users’ print jobs
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• Clearing the EX Print Server of all job data

• Printing black-and-white or color jobs

• Publishing print connections

• Deleting fonts

• Controlling print jobs from the job management tools

• Overriding job settings

• Setting default settings for print options

• Calibrating the EX Print Server

Operator privileges

Users in the Administrators and Operators groups have privileges in addition to the ones that 

you set when you create groups. Users in the Operators group control print jobs from the job 

management tools, including the following:

• Viewing the Job Log

• Deleting, viewing, and modifying other users’ print jobs

• Printing black-and-white or color jobs

• Clearing the EX Print Server of all job data

• Calibrating the EX Print Server (if allowed by the administrator)

Guest privileges (no password)

A user does not need a password to log on as a Guest from the job management tools. A Guest 

can view the status of active jobs but cannot make changes to jobs or to the EX Print Server 

state.

Print connections

The EX Print Server supports the following print connections: Hold queue, Print queue, and 

Direct connection. You enable or “publish” these print connections to users on the network 

when you configure Printer Setup. All published connections are constantly checked for the 

presence of jobs. The Print queue and Direct connection give users more direct access to the 

EX Print Server than the Hold queue. Therefore, do not publish the Print queue and the 

Direct connection in environments where maximum control is required.

In addition, you can enable the Printed queue, which is a storage area for the most recent jobs 

from the Print queue. The Printed queue allows users to reprint those jobs by using the job 

management tools (for example, Command WorkStation).

NOTE: To use the utilities and WebTools, you must enable at least one print connection.
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Hold queue

Jobs sent to the Hold queue are spooled to the EX Print Server hard disk drive for printing at 

a later time, or for reprinting. Because the Hold queue is a storage area, jobs sent to it cannot 

proceed through the printing process until the operator intervenes using the job management 

tools.

Print queue

The Print queue is the standard EX Print Server queue. Jobs sent to the Print queue are 

processed and printed in the order in which they are received. Jobs prioritized by an operator 

with the job management tools and jobs sent via the Direct connection take priority over jobs 

sent to the Print queue.

Direct connection

The Direct connection transmits jobs directly to the EX Print Server, but only when the EX 

Print Server is idle. If the EX Print Server is busy, the job remains at the user’s computer until 

the EX Print Server is ready. The job is then processed as soon as the previous job is finished 

and before the next queued job is processed. The Direct connection is intended for 

downloading fonts and for use with test applications that require back channel information 

from the EX Print Server. Generally, it is not recommended that you use Direct connection to 

print jobs. 

NOTE: To download fonts to the EX Print Server, you must first publish the Direct 

connection.

In most cases, jobs sent to the Direct connection are not stored on the EX Print Server and 

cannot be selected for reprinting, moving, or deletion. Therefore, the Direct connection 

provides a measure of security for sensitive files. Jobs sent to the Direct connection do appear 

in the Job Log, for accounting purposes. However, for full security, it is recommended that 

you use Secure Erase.

Some jobs sent to the Direct connection cause temporary files to be stored on the EX Print 

Server. This may occur with the following types of jobs:

• PDF jobs

• TIFF jobs

• Jobs with the following settings:

– Reverse order printing (for large jobs)

– Booklet Maker

– Mixed Media

– Combine Separations

– Paper Catalog
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Additional security features

In addition to the traditional security features such as passwords, you can use these features to 

keep the EX Print Server secure:

• E-mail access

• IP addresses and ports

• Secure Printing

• LDAP authentication

Controlling email access to the EX Print Server

Because you can allow users to print file attachments in email messages sent to the EX Print 

Server, the EX Print Server accepts only valid attachments (for example, PostScript or PDF 

files). Typically, viruses transmitted via email require execution by the receiver. Attachments 

that are not valid files are discarded by the EX Print Server. Because file types such as .BAT, 

.VBS, and .EXE can cause virus activity, the EX Print Server does not process these file types. 

The EX Print Server also ignores e-mails in RTF (Rich Text Format) or HTML (Hypertext 

Markup Language) format, and any included JavaScript code.

You can define lists of authorized email addresses on the EX Print Server. Any email that the 

EX Print Server receives from an email address that is not in the authorized list is deleted. For 

more information, see page 42.

Restricting IP addresses and ports

To restrict unauthorized connections to the EX Print Server, you can permit only users whose 

IP addresses are within a defined range. You can also close unnecessary ports to reject inbound 

access from the network. Commands or jobs sent from unauthorized IP addresses or ports are 

ignored by the EX Print Server.

Secure Printing

This option allows the printing of highly sensitive or confidential files. A user printing a file 

with the printer driver assigns a password to the job. The user must then enter the password at 

the digital press to print the job. For more information, see Printing.

LDAP authentication

When LDAP communication is enabled to retrieve names and other information for people 

at your site, you can specify the type of authentication. For more information, see Configure 

Help. 
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Network requirements

Before you install the EX Print Server on the network, it is strongly recommended that you 

read “Stages of installation on the network” on page 9. Step 1 of installing the EX Print Server 

on the network is to configure your network environment. You must configure network 

servers to provide users with access to the EX Print Server as a network printer.

Network protocols

When the EX Print Server is connected to a network, it behaves as a networked printer. The 

EX Print Server supports the following network protocols:

• TCP/IP, which also includes the DHCP, FTP, HTTP, IMAP, IPP, IPv4, IPv6, LDAP, 

LPD, LPR, NBT, POP3, Port 9100, SMB, SMTP, SNMP, SNTP, and SSL/TLS 

protocols

• AppleTalk (for font downloads only), Bonjour

These protocols can run concurrently on the same cable. Computers that use other protocols 

can print through a server that uses one of the supported protocols. The EX Print Server 

automatically switches to the correct protocol, and handles all connections simultaneously.

Windows networks

The EX Print Server requires a valid IP address, subnet mask, and gateway address.

Type these addresses manually or use the DHCP protocol to assign them dynamically. Make 

sure the EX Print Server name and address are listed in a domain name server (DNS) or hosts 

name database used by your system.

If more than one EX Print Server print connection is published (for example, if both the Print 

queue and Hold queue are published), consider creating a printer for each print connection, 

so that users can print to each connection directly.

Configure the EX Print Server with the correct Windows domain name.

This is especially important for Windows printing, also known as Server Message Block 

(SMB) printing. To use Microsoft Active Directory, you must assign the EX Print Server to a 

domain. If you assign the EX Print Server to a workgroup, you cannot use Microsoft Active 

Directory.

AppleTalk networks (only for font download support)

AppleTalk networks support only font downloads if you enable AppleTalk in Configure. To 

allow Mac OS computers to access Bonjour printers, you must enable Bonjour in Setup.
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UNIX networks
• When you configure a UNIX workstation with the lpr protocol and connect to the EX Print 

Server over a TCP/IP network, you can print directly to the EX Print Server.

• Setting up UNIX workstations requires an administrator with root privileges. After the 
initial configuration, UNIX users submit print jobs to a named printer. 

• The EX Print Server is a printer controller that understands lpr protocols.

• The EX Print Server has a remote printer name that you must use in order to communicate 
with it successfully. 

Regardless of the UNIX workstation you use, the name that you use for the remote printer (or 

rp in the /etc/printcap file) in configuring the network for the EX Print Server must be one of 

the following:

• print

• hold

• name of virtual printer

Computers on a TCP/IP network can print directly to the EX Print Server as a remote printer, 

or can print to a Windows Server 2003/Server 2008/Server 2008 R2/Server 2012 server or 

UNIX workstation acting as a print server.
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Physical connection to the network

Before you install the EX Print Server on the network, it is strongly recommended that you 

read “Stages of installation on the network” on page 9. Step 2 of installing the EX Print Server 

on the network is to physically connect the EX Print Server to the network. Use the network 

port on the EX Print Server.

EX Print Server connector panel
Key

1. Power connector

2. Power switch

3. USB ports 
(for keyboard, monitor, 
and spectrophotometer)

4. Network port

5. Press interface port

6. Fiber optic ports

7. Monitor (VGA) port 
(configuration may vary)

8. Bracket cover plate

NOTE: Unlabeled connectors 
are not used.

1

4

7

2

5
3

8

6
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Prepare to set up the EX Print Server

To prepare for printing at your site, you must do some initial EX Print Server configuration 

(or “Setup”) to specify the network environment and the types of printing you do. Before you 

perform Setup, decide the levels of access to implement, such as passwords and other security 

features that the EX Print Server offers. Because many of these security features are 

interconnected, review the information to plan for an effective security system, and then 

perform Setup accordingly.

Ethernet connection

For Ethernet connections, the EX Print Server supports Unshielded Twisted Pair (UTP) 

cabling for these network speeds:

• 10BaseT: Category 3 or later

• 100BaseTX: Category 5 or later (4-pair/8-wire, short-length)

• 1000BaseT: Category 5e or later (4-pair/8-wire, short-length)

TO CONNECT TO THE NETWORK

1 Power off the digital press and the EX Print Server (see page 37).

2 Connect the cable from the network to the network connector (RJ-45) on the EX Print Server 

(see page 18).

If you are concerned about information being extracted from the EX Print Server Ethernet 

port without authorization, consider securing the Ethernet port.

3 Power on the EX Print Server and the digital press.

On the EX Print Server, move the power switch to the ON position and then press the power 

button (see page 18).
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Requirements for computers and mobile devices

To install the EX Print Server user software either from the DVD or downloaded from the 

Internet, the client computer or mobile device must meet the minimum system requirements. 

The following tables list the requirements.

Minimum requirements for Windows Mac OS

Operating system Windows printer drivers and Fiery applications are 
supported on the following operating systems (with 
latest service pack):

NOTE: Both 32-bit and 64-bit versions are supported, 
unless otherwise noted.

• Windows XP: Home, Professional

• Windows Vista: Home Basic Edition, Home 
Premium Edition, Ultimate Edition, Business 
Edition, Enterprise Edition

• Windows 7: Home Premium, Professional, 
Ultimate

• Windows 8: Windows 8 Edition, Windows 8 Pro 
Edition, Windows 8 Enterprise Edition

• Windows Server 2003: Standard Edition, 
Enterprise Edition, Datacenter Edition

• Windows Server 2003: SP1 (64-bit only), R2

• Windows Server 2008: Standard Edition, 
Enterprise Edition, Datacenter Edition, Web 
Server

• Windows Server 2008 R2 (64-bit only): 
Foundation Edition, Standard Edition, Enterprise 
Edition, Datacenter Edition, Web Server, 
Itanium-Based

• Windows Server 2012 (64-bit only): Foundation 
Edition, Essentials Edition, Standard Edition, 
Datacenter Edition

NOTE: Job Monitor is not supported on 64-bit 
operating systems. 

Mac printer drivers and Fiery applications 
are supported on the following operating 
systems (on Intel-based Mac OS 
computers):

• Mac OS v10.5.x (also support for 
PowerPC G5-based Mac OS 
computers)

• Mac OS v10.6

• Mac OS v10.7

• Mac OS v10.8

Memory for printing 
and utilities (except Command 
WorkStation)

500MB (2GB recommended) 500MB (1GB recommended)

Hard disk drive space (except 
Command WorkStation)

1GB (2GB recommended) 500MB (1GB recommended)

Networking protocol TCP/IP TCP/IP, EtherTalk, Bonjour
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WebTools requirements

For more information about WebTools, see page 22.

Command WorkStation requirements

Fiery JobMaster, Impose, and Compose requirements

• Command WorkStation

NOTE: The client computer must meet all system requirements for Command WorkStation to 

use Fiery JobMaster, Impose, and Compose.

• License activation for each client computer

• Acrobat/PitStop software

Requirement Windows Mac OS

Java-enabled Internet browser • Internet Explorer 6 or later

• Firefox 10 or later

NOTE: Microsoft releases frequent updates to 
Internet Explorer. Because support cannot be 
guaranteed for all versions, use the versions 
specified for best results

• Safari 5 or later

• Firefox 10 or later

NOTE: On Mac OS, some versions of Firefox 
may not allow you to enter passwords into 
Configure. If this occurs, use Safari instead.

Display 800 x 600 screen resolution

Graphics card 16-bit color

Network protocol TCP/IP

Other • Web Services enabled on the EX Print Server

• IP address or DNS name of the EX Print Server

Requirement Windows Mac OS

Processor Pentium 4, 1.0 GHz or faster Macintosh G5, 1.6 GHz or faster

Hard disk drive space 3GB

RAM 1GB

Display 1024 x 768 screen resolution

Graphics card 16-bit color

Network protocol TCP/IP
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Mobile device requirements

Direct Mobile Printing is supported on the following mobile devices with iOS 4.2 or later and 

print functionality:

• iPad (1st generation or later)

• iPhone (4, 4S, 5)

• iPod touch (3rd generation or later)

Online help requirements

The Help files for Fiery utilities are developed for use with Microsoft Internet Explorer v5.5 

or later. If you use other browsers, such as Safari or other versions of Internet Explorer, the 

Help may not display properly.

If the browser uses a pop-up blocker, it may block Help files. If this occurs, temporarily 

disable the pop-up blocker to display Help files.

If the browser has the advanced Internet option enabled to display notifications about script 

errors, it may display a warning window before displaying a Help file. To avoid the warning 

window, clear the “Display a notification about every script error” option on the Advanced 

tab in the Internet Options dialog box. A warning message may also appear in the Status bar, 

but the content of the Help file is not affected by this error.

WebTools

The EX Print Server supports Internet or intranet access with WebTools from Windows and 

Mac OS computers. To enable WebTools, see page 27.

Home

Home provides you with current information about installed options and the jobs processing 

and printing on the EX Print Server. To use this WebTool, you do not need a password. For 

more information, see Utilities.

Downloads

Downloads allows users to download installers for printer drivers and other software directly 

from the EX Print Server. You do not need a password to use this WebTool. For more 

information, see Printing and Utilities.

Docs

Docs allows users to access, manage, and modify jobs in their mailboxes on the EX Print 

Server, and submit jobs to the EX Print Server. For more information, see WebTools Docs 

Help.
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Scan Settings

Scan Settings allows you to define scan templates from a remote computer. These scan 

templates are accessible from the digital press when you scan a file. The administrator has full 

access to all scan templates. In addition, the administrator can create new scan templates in 

Scan Settings and import and export scan templates. For general information about scanning, 

see Utilities. For information about Scan Settings, see WebTools Scan Settings Help.

Configure

Configure allows you to view and modify EX Print Server options from a network computer. 

This function requires an Administrator password.
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SETTING UP FROM A CLIENT COMPUTER

After you start the EX Print Server for the first time, or install system software, you must set 

up the EX Print Server. If you do not, default settings are used. Make sure that settings are 

appropriate for your printing environment. If your network or printing environment changes, 

you may need to adjust your settings.

Use Configure to change settings and to set up the EX Print Server. For more information, 

see page 24.

For initial Setup, you can use the Fiery Setup Wizard to configure language, regional, server, 

and print environment settings. For more information, see page 25.

About Configure

You can find more information about using Configure the following ways:

• If you access Configure from an Internet browser, in WebTools, on the Configure tab, 

click the Help icon.

• If you access Configure from Command WorkStation, see Command WorkStation Help.

TO ACCESS CONFIGURE FROM AN INTERNET BROWSER

1 Open an Internet browser and type the IP address of the EX Print Server.

2 In WebTools, on the Configure tab, click Launch Configure.

3 Log on with Administrator privileges.

TO ACCESS CONFIGURE FROM COMMAND WORKSTATION

1 In Command WorkStation, as Administrator, do one of the following:

• In the Server menu, click Configure.

• In Device Center, on the General or Users tabs, click Configure.

2 If the Fiery Setup dialog box displays, click Configure.

If you have not completed initial setup, you may want to click Fiery Setup Wizard instead. 

For more information, see “About Fiery Setup Wizard” on page 25.

If you use the Fiery Setup Wizard (from Command WorkStation or WebTools) and click 

Finish at the end of the wizard, the Fiery Setup dialog box does not display again in any 

location.
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About Fiery Setup Wizard

Fiery Setup Wizard guides the initial setup to configure the EX Print Server for the print 

environment.

Fiery Setup Wizard is only available for initial setup and when you reinstall system software. If 

you use the Fiery Setup Wizard (from Command WorkStation or WebTools) and click Finish 

at the end of the wizard, the Fiery Setup dialog box does not display again in any location.

The Fiery Setup Wizard guides you through the following procedure:

1 Choose a default language.

2 Specify regional settings.

3 Specify server settings.

4 Choose a print environment configuration.

A print environment configuration contains standard setup options for a particular print 

environment. You can choose from one of the following configurations that best fit your print 

environment:

• Graphic Arts & Proofing

• Production

• Transactional

You can also choose to use EX Print Server factory default settings for your print environment 

instead of choosing a print environment configuration.

5 Configure setup options for a chosen print environment.

After completing Fiery Setup Wizard, you can make additional changes to the EX Print Server 

in Configure.

TO ACCESS FIERY SETUP WIZARD FROM WEBTOOLS

1 Open an Internet browser and type the IP address of the EX Print Server.

2 In WebTools, on the Home tab, next to “Fiery controller initial setup is not complete” click 

“Click here to continue.”

TO ACCESS FIERY SETUP WIZARD FROM COMMAND WORKSTATION

1 In Command WorkStation, as Administrator, do one of the following:

• In the Server menu, click Configure.

• In Device Center, on the General or Users tabs, click Configure.
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2 In the Fiery Setup dialog box, click Fiery Setup Wizard.

If you need to access all available options, you may want to click Configure instead. For more 

information, see “About Configure” on page 24.

If you use the Fiery Setup Wizard (from Command WorkStation or WebTools) and click 

Finish at the end at the end of the wizard, the Fiery Setup dialog box does not display again in 

any location.
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WEBTOOLS

WebTools allows you to manage the EX Print Server remotely from the Internet or your 

company’s intranet. Once enabled, you can access WebTools from a network computer. Make 

sure that the Network Setup options are correct for your environment.

For more information about WebTools, see Utilities and Configure Help.

TO ENABLE WEBTOOLS.

1 Enable TCP/IP networking from one of the following locations:

• In Setup, perform Network Setup.

• In Configure, click Network > Protocol > TCP/IP.

2 On each client computer, do the following:

• Assign a valid, unique IP address, subnet mask, and gateway address, if required.

• Make sure that a supported Internet browser is installed and that Java is enabled in the 

browser.

TO START WEBTOOLS

1 Start an Internet browser and type the IP address or DNS name of the EX Print Server.

2 Click the tab that corresponds to the WebTool that you want to use.
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SETUP OPTION REFERENCE

The following tables describe print options (in alphabetical order) and their default values. 

If necessary, you can determine your current settings by printing the Configuration page 

(see page 36).

For information about options not listed, see Configure Help.

For more information about print options, see Printing.

PS options
• To access PS options, choose Configure > PDL > PS.

Option Settings
(default is underlined)

Description

Allow Courier Substitution Yes, No Specify whether to substitute Courier for fonts that are 
unavailable when you download files to the EX Print 
Server, or when you print a document for which you do 
not have the corresponding printer font. If this option is set 
to No, jobs with fonts that are unavailable on the EX Print 
Server hard disk generate a PostScript error and do not 
print. This setting does not apply to PDF files; font 
substitution occurs automatically in PDF files.

Cache PDF and PS objects On, Off Specify whether images in PDF and PS files are cached to 
reduce the need to reprocess the same image in a file.

Collation Collated, Uncollated Select how to output multiple-page or multiple-copy jobs.

Convert Paper Sizes No, Letter/Tabloid->A4/A3, 
A4/A3->Letter/Tabloid

Convert paper sizes in documents automatically to the 
default paper sizes specified. For example, if you select 
Letter/Tabloid->A4/A3, a letter size document is 
automatically printed on A4 paper.

This option works in conjunction with Default Paper 
Sizes. For example, if Convert Paper Sizes is set to Letter/
Tabloid->A4/A3, and Default Paper Sizes is set to US, jobs 
are printed A4/A3 size. This also includes EX Print Server 
system pages such as the Start Page, Test Page, and Job Log.
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Cover Page No, Yes Prints a cover page (job summary) with the name of the 
user who sent the job, document name, server name, 
time the job was printed, number of pages printed, and 
status of the job.

The digital press has its own feature for printing a cover 
page. If you enable this option on the digital press and also 
enable it on the EX Print Server, two cover pages are 
printed.

Default Paper Sizes US, Metric (default is US 
in the United States, 
Metric elsewhere)

Print on US paper sizes (for example, Letter, Legal, 
11x17), or Metric paper sizes (for example, A4 or A3) by 
default. When no page size is defined within a PostScript 
file, jobs are printed on Letter paper if you selected US; or 
A4 paper if you selected Metric.

DFA Profile None, Custom1, Custom 2, Custom 3, Custom 
4

Select the default finishing profile to use.

Digital Press Image Mode 160 dot, 180 dot, 210 dot, 250 dot Select the screen to use for your print job.

Media Weight 89-91 gsm (minimum). Other ranges are 
available in increments of 3 up to 350 gsm.

Select the weight of media to use.

Print Master Yes, No Select Yes to print a FreeForm master when created and 
printed to the EX Print Server. The master is retained on 
the EX Print Server after printing unless deleted later. 
Select No only to process and hold a FreeForm master on 
the EX Print Server.

Print to PS Error Yes, No Specify whether the EX Print Server prints the available 
portion of a print job when it encounters a PostScript error. 
Select Yes to print the portion of the job that was processed 
before the error occurred. Select No to cancel the print job 
entirely when a PostScript error is encountered. Leave this 
option at No unless you encounter printing problems.

Output Delivery Face down-normal order, Face up-normal order, 
Face down-reverse order, Face up-reverse order

Specify how the printed job is arranged upon output.

Output Tray Varies based on the accessories installed. Select where to output the job. 

Scale to Fit On, Off Specify whether to scale a document size to a selected paper 
size if the document size is different from the paper size. 
With the Off setting, if the document size is larger than the 
selected paper size, the document is cropped to the paper 
size when printed. 

Option Settings
(default is underlined)

Description
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PCL options
• To access PCL options, choose Configure > PDL > PCL.

Option Settings
(default is underlined)

Description

Append CR to LF Yes, No Specify whether to append a carriage return to each line feed.

Default Orientation Portrait, Landscape This PCL option determines whether the text or image is 
oriented along the short edge of the paper (Portrait) or along the 
long edge of the paper (Landscape).

Collation Uncollated, Collated Select how to output multiple-page or multiple-copy jobs.

Font Pitch (char/in) 0.44-99.99 (default is 10.00) If the default PCL font selected in Font Number represents a 
fixed pitch scalable font, determine the width of scalable type. 
Pitch is measured by characters per inch, so 10-pitch type fits 10 
characters per inch.

Font Number 0 to 999 Designate the default font for the EX Print Server. To determine 
font numbers, print the internal PCL Font List. The standard 
fonts are listed in order. The font numbers, however, are not 
listed.

Font Size (pt) 4.0-999.75 (default is 12.00) If the default PCL font selected in Font Number represents a 
proportionally spaced scalable font, determine the point size 
(height) of the font. 

Font Source Internal, Soft Font Specify the PCL font source to be enabled.

Form Length 5-128 (default is 64) Set the number of lines to be printed per page in PCL jobs.

Paper Size for System Pages US, Metric (default is US in the 
United States, Metric elsewhere)

Specify the paper size on which PCL system pages are printed. 
System pages are pages that you print from the press user 
interface, such as the PCL Font List.

Output Delivery Face down-normal order, Face up-
normal order, Face down-reverse 
order, Face up-reverse order

Specify how the printed job is arranged upon output.

Output Tray Top tray auto, Top tray 1, Top tray 
2, Top tray 3, Top tray 4, HCS 
stacker auto, HCS stacker 1, HCS 
stacker 2, HCS stacker 3, HCS 
stacker 4, HCS bypass, DFA 
finisher

Select where to output the job. 

Symbol Set PC-8, DESKTOP, ISO-60, 
ROMAN-S, PC-8 DN, ISO-69, 
ROMAN-9, ISO L1

Choose the PCL symbol set that best matches the needs of users 
printing to the EX Print Server.
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BACK UP AND RESTORE SETTINGS

You can back up and restore selected settings or the entire EX Print Server configuration.

Backup/Restore

Use the Backup/Restore feature when the EX Print Server is operating normally and you want 

to apply groups of saved configuration settings to the EX Print Server. For more information, 

see page 31.

Fiery System Restore

Use Fiery System Restore to recover from a system crash or hard disk failure. For more 

information, see page 32.

Backup/Restore

Using the Backup/Restore feature in Configure or Command WorkStation, you can back up 

EX Print Server selected settings and restore them later, without reinstalling system software. 

When you back up settings, you save a configuration file with the settings.

You can back up and restore the following EX Print Server settings:

• Fiery system settings

• Color settings

• Scan settings

• FreeForm/VDP Resources

• Virtual printers

• Server presets

• Fonts

• Job Log

For more information, see Configure Help or Command WorkStation Help.

You cannot use this feature to back up or restore the Paper Catalog database. For information 

about exporting the Paper Catalog database, see Command WorkStation Help.
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TO BACK UP FROM BACKUP/RESTORE

1 In Configure > Server > Backup/Restore, click the Backup button.

Alternative procedures about using Backup/Restore from Command WorkStation are 

available in Command WorkStation Help.

2 In the Backup dialog box, select settings and click Next.

3 Enter a file name, select a location, and click Next.

4 Click Finish.

TO RESTORE FROM BACKUP/RESTORE

1 In Configure > Server > Backup/Restore, click the Restore button.

Alternative procedures about using Backup/Restore from Command WorkStation are 

available in Command WorkStation Help.

2 In the Restore dialog box, browse to the configuration file that you created earlier and click 

Next.

3 Select settings and click Next.

4 Click Finish.

Fiery System Restore

The EX Print Server system installer allows you to back up or restore the entire system to 

recover from a system crash or a hard disk failure. After reinstalling system software, you can 

create a new system backup partition of the EX Print Server, load a system recovery partition 

to restore the EX Print Server to an earlier state, or use utilities to troubleshoot and administer 

the EX Print Server.

After selecting a system language, you must select one of the following options.

• New Installation: Install new system software.

NOTE: The EX Print Server is shipped with preinstalled system software. If you must reinstall 

system software, contact a service technician.

• Restore from backup or recovery partition: Restore an earlier backup partition, or the 

default EX Print Server configuration. If you have not created a backup partition, this 

option allows only a recovery to the default configuration and “Restore from recovery 

partition” is displayed.

• Back up hard disk drive(s): Back up the hard disk to external media, such as a USB flash 

drive or network share location.

• Platform Utilities: Use the system installer for advanced procedures, such as erasing hard 

disks, or use Windows Task Manager to administer the EX Print Server.
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TO BACK UP THE EX PRINT SERVER

1 Select “Back up hard disk drive(s).”

2 Configure the backup image settings.

• Select a backup destination from one of the following types of media: USB flash drive, 

external hard disk drive, local hard disk drive, or network share.

• Name the backup image folder. The folder name contains the name that you assign and a 

time stamp of the backup image. The default name is the server name. The installer 

automatically generates the time stamp.

• Enter a description of the backup image.

• Select the appropriate check boxes to include Fiery job files in the backup image or create 

bootable media with the backup.

• Save the backup image settings.

3 Start the backup process.

The installer begins creating the backup image.

TO RESTORE THE EX PRINT SERVER TO AN EARLIER CONFIGURATION

1 Select “Restore from backup or recovery partition.”

If you have not previously created a backup image,“Restore from recovery partition” is 

displayed.

2 Select the source of the backup.

Select one of the following options.

• One of the two most recently-created backup images.

• The recovery partition, which restores the default system settings from a hidden hard disk 

drive partition.

• Search for a backup that you have created on the EX Print Server.

The installer begins the recovery process.

NOTE: If you must search for backups, use the following steps.

3 Select a backup image.

The installer lists each backup image in the following categories.

• Location of the backup image: USB flash drive, external hard disk drive, network location, 

or local hard disk drive

• Time at which you created the backup image

• Folder location of the backup image
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4 Click OK.

The system is restored.
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ADMINISTRATION

The EX Print Server includes many features to help you manage printing, performance, and 

security.

Install and configure printer drivers

Before you can print from a client computer to the EX Print Server, you must first install a 

printer driver on each client computer and then configure them to include EX Print Server 

and digital press installed options.

After you install and configure printer drivers, you can print from any application on a client 

computer to the EX Print Server.

For more information about installing printer drivers, including installing printer drivers on 

other operating systems, see Printing.

Operating system passwords

Since the EX Print Server is a Windows-based system, a password for the Windows operating 

system is also required, which is separate from the Administrator and Operator passwords. 

The default Windows operating system password is Fiery.1 (case-sensitive). It is strongly 

recommended that you change passwords periodically to protect the EX Print Server from 

unauthorized changes.

For more information about passwords, see “Passwords” on page 12.

TO CHANGE THE OPERATING SYSTEM PASSWORD

1 Access the EX Print Server from the Fiery Advanced Controller Interface (FACI) or Remote 

Desktop (see page 39) and log on with Administrator privileges.

2 Press Ctrl+Alt+Delete.

3 Click Change Password.

4 Enter the old and new password, and then confirm the new password.

5 Press Enter.
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Printing the Configuration page

The Configuration page lists the settings in effect for the current Setup. After you perform 

Setup, print a Configuration page to confirm your settings. Post the current Configuration 

page near the EX Print Server for quick reference. Users need the information on this page, 

such as the current printer default settings.

TO PRINT THE CONFIGURATION PAGE FROM COMMAND WORKSTATION

• In Command WorkStation, click File > Print > Server Configuration.
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Starting, shutting down, rebooting, and restarting the EX Print Server

Generally, you can leave the EX Print Server and the digital press running all the time. This 

section describes how to start, shut down, reboot, and restart the EX Print Server when 

necessary.

Restarting the EX Print Server resets the EX Print Server system software, but does not reboot 

the entire system. Network access to the EX Print Server is temporarily interrupted and all 

currently processing jobs are terminated.

If you use a USB flash drive, remove it before rebooting. Otherwise, the EX Print Server does 

not reboot.

TO START THE EX PRINT SERVER

• Press the EX Print Server power button once.

Make sure that on the connector panel, the power cable is connected and the power switch is 

in the ON (|) position, and then press the power button once.

TO SHUT DOWN, RESTART, OR REBOOT FROM THE FIERY ADVANCED CONTROLLER INTERFACE (FACI)

1 Make sure that the EX Print Server is not receiving, processing, or printing any files.

If the system has just finished processing, wait at least five seconds after the system reaches 

Idle before you proceed.

2 Close all applications except FieryBar.

3 Do one of the following:

• Click the Windows Start button and select Shut Down.

• Click the Windows Start button, click the arrow next to Shut Down, and select Restart.

• Right-click FieryBar and, in the shortcut menu, select Restart Fiery. Click OK.
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Configure proxy settings

System Updates is not supported on the Xerox® iGen™ 150 Press. However, if you use a 

proxy server, you still need to access System Updates to configure proxy settings. For other 

products, System Updates is used to schedule updates to system and user software on the EX 

Print Server. 

For more information about updating the EX Print Server, see your service representative.

TO CONFIGURE PROXY SETTINGS

1 From Configure, click Server > System Update and select Enable System Updates (see “About 

Configure” on page 24).

2 Click Proxy Settings. In the Proxy Settings dialog box, select Enable Proxy and enter the 

following information:

• Address: proxy server IP address

• Port: port used by the proxy server

• User Name: user name for accessing the proxy server

• Password: password for accessing the proxy server

3 Click Save.

Clear the Enable System Updates check box. Your proxy settings remain valid and are not 

affected.

4 From Configure, click Apply.
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Remote Desktop

Since the EX Print Server is Windows-based, you can use Remote Desktop to access the EX 

Print Server from a remote computer.

Remote Desktop Connection is a Microsoft application that allows you to access one 

Windows computer from another. To use EX Print Server with Remote Desktop, you must 

enable Remote Desktop in Setup and on the client computer.

TO USE REMOTE DESKTOP

1 On the press user interface, in Setup, enable Remote Desktop.

2 On a client computer, in Configure, click Network > Protocol > TCP/IP > Security. In the list of 

available ports, select port 3389 (Remote Desktop).

For more information, see “About Configure” on page 24.

3 On the remote computer, click the Windows Start button and in All Programs > Accessories, 

click Remote Desktop.

4 Type the EX Print Server IP address or DNS name and click Connect.

5 If prompted, type the Administrator password.
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Clearing print jobs

The Clear Server command allows you to clear all queued print jobs from the EX Print Server 

Print, Hold, and Printed queues. Jobs can also be deleted, individually or as a group, using 

Command WorkStation. Clear Server also clears all jobs archived on the EX Print Server hard 

disk, the index of archived jobs, and all FreeForm masters.

TO CLEAR JOBS ON THE EX PRINT SERVER

• In Command WorkStation, choose Clear Server from the Server menu.

For more information, see Command WorkStation Help.

Back up your original data on your own media at the same time you store and save data on the 

EX Print Server hard disk. Never damage or reset the EX Print Server hard disk, and do not 

turn off the system while accessing the hard disk. For instructions on how to turn on and turn 

off the EX Print Server, see page 37.

If the EX Print Server hard disk or system software experiences technical difficulties, data 

stored and saved on the EX Print Server hard disk may be irretrievably lost. If problems with 

the hard disk occur, extended storage of the following data cannot be assured:

• Third-party fonts 

• Print jobs

• Color profiles, including profiles downloaded or edited using Spot-On

• Job notes and instructions

• Scanned image data

• Jobs edited using Impose

• Variable data documents

• Email Service Address Book

• EX Print Server configuration information (list of all the settings in effect for the current 

Setup)
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Printing from a USB flash drive

You can print files on a USB flash drive to the EX Print Server. To do so, save PS, PCL, EPS, 

TIFF, and PDF files to the USB flash drive and download them directly to the EX Print 

Server. You can print files that originated on Mac OS or Windows computers.

You can print files automatically from a USB flash drive to one of the standard print queues 

on the EX Print Server (Print, Hold, or Direct) or to published virtual printers (if supported). 

Verify with your administrator that these connections are published in Setup.

For more information about printing, see Printing.

TO CONFIGURE AUTOMATIC PRINTING WITH A USB FLASH DRIVE

1 Set printing options.

• In Configure, click Network > Port > USB.

• Select Enable USB Port.

• For Default Queue, select the connection to which the EX Print Server downloads files 

that do not specify a connection.

• Set USB Media Autoprint to Print All.

2 On a computer, create folders at the top (root) level of the USB flash drive named Print, Hold, 

and Direct.

3 Save the files from the computer to the USB flash drive.

When you connect the USB flash drive to the EX Print Server, files copied to the Print, Hold, 

and Direct folders are downloaded to the corresponding print connection on the EX Print 

Server.

Files copied to the root level of the USB flash drive (and any folder below the root level that is 

not named for a print connection) are downloaded to the queue that you configured for USB 

printing.

Prepare the USB flash drive with the correct folder structure and appropriate files before the 

USB flash drive is connected to the EX Print Server. Because file processing begins as soon as 

you connect the USB flash drive to the EX Print Server, there is no time to do any file 

management tasks, such as moving files to a different folder or deleting files.

4 Remove the USB flash drive from the computer and connect it to the USB port on the EX Print 

Server.

For the location of the USB flash drive port, see page 18. 

Make sure that the USB flash drive is properly stopped before you disconnect it from the 

computer.
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Email address books

You can manage email/Internet Fax addresses by sending email messages in a particular format 

to the EX Print Server, and perform tasks such as overwriting the address book, adding new 

addresses, removing addresses, and retrieving current addresses on the EX Print Server.

Users can use the address books when they send attachment files to the EX Print Server.

The EX Print Server supports a maximum of 1,000 entries in each address book.

NOTE: Email messages can be sent only from an administrator account.

Types of address books

The EX Print Server supports different types of address books that allow control over sending 

emails and files to recipients, and print jobs.

• Admin: allows members to modify the address book, get the current address book from the 

EX Print Server, cancel a job, or receive the status of a job. However, membership in this 

address book does not provide the same privileges as the Administrator password 

(page 35).

• Print: includes users who have print access. Users who have e-mail addresses in the Print 

address book are authorized to submit jobs by e-mail to the EX Print Server. Unauthorized 

users receive an e-mail reply that their job was not accepted by the EX Print Server for 

printing.

• Fax: used for Scan to Internet FAX. This address book is used for sending scan files via 

Internet FAX to the EX Print Server. You cannot use addresses in the address book to send 

an e-mail to the EX Print Server. 

• Corporate: an LDAP address book used for Scan to email. The Corporate address book 

allows users to send files using Remote Scan to a list of addresses registered on an LDAP 

server.

• User: includes users who have scanning access.

Perform LDAP Setup before setting the User address book. For more information, see 

Configure Help.

When a print job is submitted via email, the EX Print Server first checks the Print address 

book. If the user’s e-mail address does not match any entry in the Print address book, the job 

does not print. Instead, the user receives an e-mail stating that the print job was not accepted.

The default wildcard character “@” is stored in the Print address book. This allows any user to 

print to the EX Print Server until the administrator adds the first entry in the Print address 

book.

To manage address books, send an email to the EX Print Server with commands in the 

Subject and Message fields. The EX Print Server responds by e-mail with information about 

each request, as described in the following table.
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To add or remove more than one address at a time, list the addresses on separate lines in the 

message field of the email.

Restoring address books

To restore address books for yourself or for users, use an email client to restore them from the 

EX Print Server.

TO RETRIEVE AN ADDRESS BOOK FROM THE EX PRINT SERVER

1 Start your email application.

2 Open a new message window.

3 Type the email address of the EX Print Server in the To line.

4 Type the command and the address book name in the Subject line.

For example, to retrieve the User address book, type “#GetAddressBook User.” 

5 Send the message.

The return message includes the addresses of the specified address book.

6 Copy the addresses to a text file or save the message for your records.

TO RESTORE AN ADDRESS BOOK TO THE EX PRINT SERVER

1 Start your email application.

2 Open a new message window.

3 Type the email address of the EX Print Server in the To line.

4 Type the command and the address book name in the Subject line.

For example, to restore the User address book, type “#GetAddressTo User.” 

5 Copy the addresses to the body of the email with each address on a separate line.

You can include nicknames. However, when a nickname or address is longer than one line, 

edit it to fit on one line.

6 Send the message.

7 In the return email message, confirm that the addresses were restored correctly.
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Administrator commands for managing address books

You can use an email client to manage the address books that are stored on the EX Print 

Server.

Task Administrator 
subject field 

Administrator 
message field 

E-mail response 
subject field

E-mail response 
message field 

To retrieve 
a specific 
address book

#GetAddressBook
name of address book 

For example:
#GetAddressBook Admin

 Address Book name of 
address book

For example:
Address Book Admin

List of addresses in the 
specified address book

To add an address 
to an address book

#AddAddressTo
name of address book

For example:
#AddAddressTo Print

name@domain 
or
“display name” <name@domain> 

Added to Address Book 
name of address book

For example:
Added to Address Book 
Print

List of addresses added 
to the address book

The EX Print Server 
also lists any addresses 
that cannot be added 
and includes the reason.

To clear an 
address book

#ClearAddressBook
name of address book

For example:
#ClearAddressBook User

Address Book name of 
address book cleared 

or 

Address Book name of 
address book not cleared

For example:
Address Book User 
cleared 

If the address book is 
not cleared, the reason 
is given.

To delete an 
address from an 
address book

#DeleteAddressFrom
name of address book

For example:
#DeleteAddressFrom User

name@domain
or 
“display name” <name@domain>

Removed from Address 
Book name of address 
book

For example:
Removed from Address 
Book User

Deleted Address 1
Deleted Address 2

The EX Print Server 
also lists any addresses 
that cannot be deleted 
and includes the reason.

To receive help for 
e-mail services

#Help RE: Help Provides 
troubleshooting 
e-mail syntax
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Mobile device printing

Direct Mobile Printing allows direct wireless printing to the EX Print Server from supported 

mobile devices. Supported mobile devices must be connected to the same wireless-network 

subnet as the EX Print Server to print using Direct Mobile Printing.

EX Print Server Setup for Direct Mobile Printing

Before using Direct Mobile Printing, configure the following settings in Configure:

• Network > Protocol > TCP/IP > Security:

Specify ports to turn or select Enable Port Filtering

Available Ports > 5353 (Multicast DNS): selected

Available Ports > 80 (HTTP): Selected

Available Ports > 631 (IPP): Selected

• Network > Services > Web:

Enable Web Services: Selected

Enable IPP: Selected

• Network > Services > Bonjour:

Enable Bonjour: Selected

Enable Direct Mobile Printing: Selected

• Printer > General:

Publish Print Queue: Selected

Make sure that the EX Print Server settings are configured as specified. Direct Mobile 

Printing will not work if these settings are changed.

For more information about these settings, see Command WorkStation Help.
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Additional Direct Mobile Printing requirements

Direct Mobile Printing requires network and security configuration to print jobs sent from 

mobile devices.

Follow these configuration requirements:

• You can print documents with a secure password using Fiery User Authentication (see 

page 11).

• If Direct Mobile Printing is running on more than one EX Print Server, be sure to assign a 

distinct Bonjour name to each EX Print Server.

User authentication problems occur if more than one EX Print Server is assigned the same 

name.

• Verify that the EX Print Server is connected to a wireless access point on the network.

• Verify that supported mobile devices are connected to the same wireless network as the EX 

Print Server.

For more information on using Direct Mobile Printing, see Printing.
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VDP Search Path

The EX Print Server can search multiple locations both on network computers and on the EX 

Print Server for VDP (Variable Data Printing) resources (for example, Postscript images and 

fonts). With Configure, you can specify a location to search by setting a “file search path” 

(sometimes also called a “common global search path”). Inform users of the paths that you 

specify so that their jobs can access the resources.

The EX Print Server searches for a VDP resource in the following order:

• Path that the user specified in the job

• Paths specified in Configure

• Path that the application specifies for VPS or PPML resources when it generates the data 

stream

For any of these paths, the EX Print Server searches the folder, and then the subfolders within 

that folder. 

TO SPECIFY LOCATIONS TO SEARCH FOR VDP RESOURCES

1 In Configure, in PDL  >  VDP, click the Add button.

For information, see “About Configure” on page 24.

2 In the Add Path dialog box, enter a path.

If you type the path name, use the format of a mapped drive (for example, Z:\folder) or a 

UNC (for example, \\computer name\folder).

3 If the path is located on a computer that requires authentication, select Remote Server 

Authentication, enter a user name and password, and click OK.

4 Repeat steps 2 and 3 as needed to add additional paths.

5 Click Apply.
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User-defined search paths for a single job

A user can enter a single search path when the user sends the job from a Windows printer 

driver, or when someone later overrides the job to include a search path. The path must be 

fewer than 256 characters, and in the format of a mapped drive (for example, Z:\folder) or a 

UNC (for example, \\computer name\folder).

To use a mapped drive, it must be recognized by the EX Print Server. For example, if the user 

specifies a path on the user’s computer (for example, C:\My Documents\VDP), the EX Print 

Server assumes this is the C:\ drive on the EX Print Server. In another example, if “Z:” is a 

network drive that users access on their network, the EX Print Server does not know the 

location to which “Z:” refers. Therefore, you must map a drive so that the EX Print Server also 

recognizes the location where resources are stored.

Mapping a drive

To map drives to the EX Print Server, you must access Windows through either the Fiery 

Advanced Controller Interface or Remote Desktop.

TO MAP A NETWORK DRIVE

1 From a Windows Explorer window, choose Tools > Map Network Drive.

One method of accessing an Explorer window is to choose Start > Documents > 

My Documents.

2 From the Drive menu, choose a letter that is not currently mapped. 

3 In the path field, type the UNC of the network computer that contains the shared resources, 

or click Browse and locate the computer on the network.

4 Click Finish.

5 If you are prompted to enter a network password, type Administrator in the Connect As field, 

type the password in the Password field, and then click OK.

6 Inform the user to use the drive letter in the VDP search path when the user sends the job to 

the EX Print Server.
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Maintaining optimal EX Print Server performance

The EX Print Server does not require maintenance. In addition to servicing and maintaining 

the digital press and replenishing consumables, you can improve the overall performance of 

your system by regularly monitoring the performance of the EX Print Server.

• Make the best use of your network connections.

Publish only connections that will be used. The EX Print Server constantly checks all 

published connections, even if they are inactive. 

Review the published connections by printing a Configuration page. Eliminate the 

connections that are not being used. It is easy to re-establish them when needed.

• Leave less urgent jobs to times when there is less network traffic or printing.

You can print recurring print jobs or jobs that are not urgent to the Hold queue. At low-traffic 

times, the administrator or a user of the job management tools with Operator privileges can 

move (or copy) all the Hold queue jobs to the Print queue for printing.

• Reduce unnecessary network communication.

Large numbers of users running Fiery utilities, especially with frequent updates, may have a 

significant effect on EX Print Server performance.

• Make sure that you have adequate disk space on the EX Print Server.

Periodically review the list of jobs in the Hold queue, and the number of jobs being retained 

in the Printed queue.

An administrator can print or delete jobs that are in the Printed queue and Hold queue. 

Consider printing or offloading inactive jobs. If disk space on the EX Print Server is 

frequently low, you can disable the Printed queue and choose not to publish the Hold queue 

(in Printer Setup).

To move or remove queued jobs, use the job management tools. When you free up disk space 

by removing inactive jobs, new jobs are spooled and printed more quickly.
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TROUBLESHOOTING

Startup diagnostics are described in the documentation for service technicians. Contact your 

authorized service/support center if you see startup error messages on Command WorkStation 

or if the EX Print Server does not reach the Idle state.

Job error reports

If errors occur when the EX Print Server is processing or printing jobs, you can submit a job 

error report to Technical Support.

The job error report captures important information for Technical Support to troubleshoot 

and resolve issues such as job errors, system failures, or unexpected print output. Job error 

reports collect job files, logs, and information about the EX Print Server.

When you create a job error report, Command WorkStation collects job files, logs, and 

information about the EX Print Server, and saves them to a zip file. Before sending the zip file 

to Technical Support, you can remove any files contained in the zip file for security purposes.

NOTE: Print jobs do not need to be in an error state for generating job error reports. You can 

create a job error report for any jobs in the Held or Printed queues.

TO CREATE A JOB ERROR REPORT

1 In Command WorkStation, select a job in the Printed or Held list. 

2 On Windows, press Ctrl and right-click the job. On Mac OS, press Command and right-click the 

job.

3 In the shortcut menu, click Create Error Report.

4 Enter information about the job error.

• Enter comments and any additional details in the text field, such as steps for Technical 

Support to reproduce the error.

• (Optional) Attach files to the report, such as a PS file.

5 Save the job error report to a specified folder.

Runtime error messages

For error messages related to canceling jobs and printing, including the Disk Full message and 

alerts to load media, see Command WorkStation Help.

You can turn on PostScript error reporting as a print option from Mac OS applications.
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Printer not found

Most failures to find a printer on the network are due to conflicting or missing name or 

address settings for the EX Print Server. You must enter names in specific places. The required 

names are:

• TCP/IP host name (also known as the DNS name), which is defined by your organization.

Enter the host name as the Server Name in EX Print Server Setup.

• Remote printer (internal machine) name. Use one of the following:

– print

– hold

– direct

NOTE: If you change the DNS name (TCP/IP host name) of the EX Print Server, you must 

reconfigure one of the utilities on each computer.
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For the appropriate name, see the following table. 

Cannot connect to the EX Print Server with utilities

If users cannot connect to the EX Print Server, check the following:

EX Print Server Setup: The appropriate network protocol must be enabled, with the correct 

parameters (for example, for TCP/IP, the IP address), and you must publish the Print queue 

or Hold queue. 

You can check these settings quickly by printing a Configuration page.

On the client computer: The appropriate network protocols must be loaded.

In this location For this item TCP/IP networks See

Setup Server Name option Administrator defines 
name

page 24

Windows hosts file host name DNS name

(TCP/IP host name)

page 16

Windows setup for 
TCP/IP 

lpd host name DNS name

(TCP/IP host name)

page 16 

Name of printer on lpd 
host machine

print, hold, or direct

UNIX /etc/printcap file 
(BSD)

rp line print, hold, or direct page 17

Solaris lpadmin queuename print, hold, or direct

Add New Server dialog box, 
when configuring a utility

Server Name DNS name

(TCP/IP host name)

Utilities
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Cannot connect to the EX Print Server with Command WorkStation 

If a problem occurs while you are connecting to the EX Print Server, an error message is 

displayed.

The problem can occur when:

• The EX Print Server is initially turned on.

• The EX Print Server restarts.

• You have changed settings affecting the server address and have not reconfigured the 

connection to the server.

If you experience this problem, try the following solutions, in this order:

• A remote computer running utilities or WebTools may be interfering by obtaining status 

information. If possible, close the remote application, and try to connect again.

• Restart the Command WorkStation software and try to connect again.

• Restart the EX Print Server.
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